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Introduction 
The Secretary of State’s Office publishes the official version of all state administrative 
rules in the Colorado Register and the Code of Colorado Regulations (CCR), as 
required by the State Administrative Procedure Act (CRS § 24-4-103). To ensure rules 
are published accurately and on time, agencies must follow a uniform format for 
readability, accessibility, and consistency. 

All rule filings are submitted electronically through the Secretary of State Office’s eFiling 
system. Agencies use this system to file both notices of proposed rulemaking and 
adopted rules.  

The Attorney General’s Office and Office of Legislative Legal Services also receive 
filings through this system.  

Additionally, agencies are required to send proposed rule notices to the Colorado Office 
of Policy, Research & Regulatory Reform (COPRRR) that is under the Department of 
Regulatory Agencies (DORA). 

This Styling Manual outlines five steps for submitting your rulemaking documents to our 
office. 

The Styling Manual and Templates page offers a reference template and example rule 
document to assist you with meeting with our guidelines. 

 Getting Started 

• If you do not have a login, email the Administrative Rules Program staff at 
rules@coloradosos.gov to request a login for the eFiling system. 

• Please provide the following information for each employee who needs an account:  
o Full name (first and last) 
o Agency or division name 
o CCR number(s) for the rule series requiring access 
o Work email address 

  

https://www.coloradosos.gov/pubs/CCR/styling.html
mailto:rules@coloradosos.gov
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 Step 1 - Create New Rule or Download Previous Rule Version 
New rules: Use the “Blank template - use for new rules (DOTX)” to draft your rule. It 
includes built-in styles for proper formatting. 

1. Go to www.coloradosos.gov  
2. Under “Business” select “Administrative rules of state agencies.” 
3. Under “Help & resources” select “Styling manual and templates.” 
4. Select “Blank template - use for new rules (DOTX).” The corresponding Word 

document will download automatically. 
5. Open the downloaded file and add your rule content directly to it. 

 

Amendments: Download the latest version of the rule from the eFiling system and 
make edits directly in that file. 

1. Go to www.coloradosos.gov  
2. Under “Business” select “Administrative rules of state agencies.” 
3. Under “Submit & manage rules”, click “Log in to eFile.” 
4. Login with your account information. 
5. Click on “Download the latest version of a rule.” 
6. Select the rule you wish to update. The corresponding Word document will 

download automatically. 
7. Open the downloaded file and make your amendments directly within it. 
8. Since this document has already been published, our office has applied the 

appropriate styles. Please continue using these styles when making edits. For a 
quick reference of our styles, open the CCR Template with Suggested 
Formatting. 

 

Repeals: Download the latest version of the rule from the eFiling system and make 
edits directly in that file. A rule is repealed through normal rulemaking procedures. 

1. Go to www.coloradosos.gov  
2. Under “Business” select “Administrative rules of state agencies.” 
3. Under “Submit & manage rules,” click “Log in to eFile.” 
4. Login with your account information. 
5. Click on “Download the latest version of a rule.” 
6. Select the rule you wish to update. The corresponding Word document will 

download automatically. 
7. Open the downloaded file and make your amendments directly within it. 

  

http://www.coloradosos.gov/
http://www.coloradosos.gov/
http://www.coloradosos.gov/
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 Step 2 - Accessibility 
In accordance with Colorado’s accessibility rules and statutes, all public entities and 
state agencies must comply with the accessibility standards established by the 
Governor’s Office of Information Technology (OIT) when submitting documents to be 
published with the Secretary of State’s Office. CRS §§ 24-34-802(1) and 24-4-103(12). 

All individuals and entities are encouraged to submit their filings ahead of their relevant 
filing deadlines, as the Secretary of State’s Office will, where possible, evaluate whether 
filings are compliant with 8 CCR 1501-11, Rule 11.5, and require inaccessible 
documents to be resubmitted in an accessible format. Failure to submit compliant 
documents may impact a rulemaking deadline, including publication, adoption, and 
effective dates. 

While we are happy to answer questions, please note that the Secretary of State’s 
Office cannot provide accessibility training or make documents accessible on your 
behalf. 

Check Accessibility in Microsoft Word 
1. Go to the “Review” tab in the ribbon.  
2. Click “Check Accessibility.”  
3. The “Accessibility Checker” pane will appear on the right, showing any issues 

found.  
 

Font 
• Do not overuse bold and italics. Use sparingly and purposely. 
• Do not underline for emphasis at all. 

 
Heading Hierarchy 

• Start with a Heading 1 (H1). 
• Each document should have one, and only one, unique H1. 
• Nest headings and don’t skip levels. 
• Do not exceed more than five or six levels of headings. 
• All documents must have the appropriate heading structure. Ensure headings are 

applied whether they are flagged or not.  
 

Alt Text for Images 
Alternative (or ‘alt’) text is a description of an image or other non-text object that can be 
read by assistive technology. 

• Make it brief but accurate. 
• Think about context. 
• If the image has a function, describe it. 
• Avoid images that contain text. 
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• AI-generated descriptions aren’t always accurate. To ensure compliance and 
accessibility, review all images and confirm the alt text is correct. 

 
Tables 
For tables in a rule to be searchable, create simple tables in Microsoft Word. Do not 
merge cells, unless they are part of the table’s header rows. 

Tables should organize information. They should not serve as a visual layout or design 
tool. Using tables for design can make content harder to understand and less 
accessible. 

• Use tables for data. 
• Designate a header row. 
• Add a title. 
• Repeat header row at the top of each page. 

 
Avoid: 

• Do not allow rows to break across pages. 
• Do not use tables for visual/layout reasons. 
• Do not make tables too complex. 
• Do not nest a table within a table. 
• Do not split or merge cells. 
• Do not include blank rows or columns. 

 
Watch Microsoft’s support video on Creating accessible tables in Word. 
 
Lists - Numbered and Bulleted Paragraphs 
Numbered and Multilevel Lists: Use the “Numbering and Multilevel List” options in 
Word to apply a list style. Enter your rule text, press “Enter” to add the next number and 
use “Tab” to create indented sub-lists. The CCR template includes a predefined 
numbered list and multilevel list section. If needed, you can create a custom multilevel 
list. 

Bulleted Lists: Use the “Bullets” option in Word to insert bullets. Select the appropriate 
paragraph style, insert a bullet, then type or paste the text for the bulleted paragraph. 

Formatting Tips: Always use Microsoft Word’s built-in list, numbering, and bullet 
features. 

https://support.microsoft.com/en-us/office/video-create-accessible-tables-in-word-cb464015-59dc-46a0-ac01-6217c62210e5
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Lists – Numbered and Bulleted Paragraphs Options in Word: 

 

If you encounter spacing issues, apply the ‘List Paragraph’ style from the CCR template, 
then reapply numbering, bulleting, or multilevel list formatting as needed. 

Step 3 - Formatting 
Ensure your document meets formatting requirements. 

• Use Arial, size 12, for all rule text. 

• In the Word ribbon, open the “Styles Preview:” 

 
• Use only the styles provided in the CCR Template. After saving the template, 

you’ll find custom styles in the ”Style Gallery“ on the ”Home“ tab. 
The CCR Template uses built-in styles to control font, spacing, and indentation. 
Applying these styles keeps your rule text clean, consistent, and professional. It 
also saves time by preventing common formatting issues. You won’t need to 
manually adjust tabs or spacing. 

• Use built-in heading styles for heading structure. 
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 Step 4 - Add, Delete, or Edit Content 

1. Navigate and Edit 
Open the “Navigation Pane:” Go to the “View” tab and check “Navigation Pane” to 
easily move between headings. 

 

2. Copy and Paste Text 
When copying text from another document, paste it using the “Keep Text Only” 
option (clipboard icon with the letter “A”) under “Paste Options” to prevent unwanted 
formatting. 

Note: This removes bold, italics, and underlining, which are not recommended in rule 
text. 
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Note: You do not need to copy and paste the entire rule if only specific sections are 
changing. To indicate that there are no changes, include a publication note in 
brackets. Example: 

Add Publication Notes to Proposed Rules and Redline Documents (Optional) 

Publication notes are encouraged and can be helpful. To ensure accessibility, 
enclose the note in square brackets and begin with the phrase “Publication Note.” 
Using a different font color is also acceptable. Publication note example: 
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3. Show Changes in Proposed Rules and Redline Documents 
Use Track Changes to show deletions and edits. 

Refer to Microsoft’s support page for detailed instructions on Track Changes in 
Word. 

An example of a redlined document is available on the Styling Manual & Templates 
page. 

 

Example of Track Changes in Proposed Rules and Redline: 

 

  

https://support.microsoft.com/en-us/office/track-changes-in-word-197ba630-0f5f-4a8e-9a77-3712475e806a
https://support.microsoft.com/en-us/office/track-changes-in-word-197ba630-0f5f-4a8e-9a77-3712475e806a
https://www.coloradosos.gov/pubs/CCR/styling.html
https://www.coloradosos.gov/pubs/CCR/styling.html
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4. Prepare Adopted Rules 
Provide a clean copy without track changes, comments, or strikethrough text. 
Publication notes, if provided, should remain in the submitted clean copy. 

To finalize:  

• Open the redline document. 
• Use the “Accept” button in the “Tracking” section to accept all changes. 
• Save as a new document (your adopted rules). 

 

Example of Accepted Track Changes in Adopted Rules: 

 

  



 

12 
 

 Step 5 - Proofread and Submit Word Document 

Proofread 
Having a second pair of eyes to review your document is essential to catch errors such 
as misspellings, incorrect numbering, and other inconsistencies.  

We also recommend using Microsoft’s ‘Editor’ feature to check for spelling errors. 

The Secretary of State’s Office is not authorized to correct typographical errors to rule 
text, unless an agency files a correction request in accordance with CRS § 24-4-
103(11)(d). 

Submit your Word Document(s) 
Submit your documents using our eFiling system. While adopted rules are already 
required to be submitted in Microsoft Word format, we are now requiring that all rule-
related documents be submitted in Word format (.doc) because they are also published 
in the Colorado Register.  

This helps streamline processing and ensures better accessibility. Word files are much 
easier to make accessible and support automated accessibility checks, whereas Adobe 
PDFs require manual tagging, which can be time-consuming and complex. 

Instructions for logging in: 

1. Go to: www.coloradosos.gov 
2. Under “Business”, click “Administrative rules of state agencies.” 
3. Under “Submit & manage rules”, click “Log in to eFile.” 

  

https://www.coloradosos.gov/
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 Rulemaking Filings & Document Best Practices 

1. Notice of Proposed Rulemaking (First Filing) 
Required Document(s): 

• Proposed Rule  
o Published in the Colorado Register. 
o Must use Track Changes in Word. Do not use strikethrough formatting, as it is 

not accessible. 
o Must be in .doc format. 
o Must be accessible. 
o Ensure this document has been reviewed to confirm it contains no hidden or 

sensitive information. Use Word’s “Document Inspector” to remove any 
metadata, comments, or other content that should not be publicly accessible. 

 
Optional Document(s): 

• Additional Information 
o Published in the Colorado Register. 
o Must be in .doc format. 
o Must be accessible. 

 
Best Practices: 

• Ensure edits are clear and accessible. 
• Include all relevant context for stakeholders. 
• Verify formatting before submission. 
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2. Adoption Notice / Request for AGO (Second Filing) 
Required Document(s): 

• Clean Copy of Rules  
o For publication in the Code of Colorado Regulations (CCR) and Colorado 

Register. 
o Must be free of tracked changes and comments. 
o Must be in .doc format. 
o Must be accessible. 

 
• Statement of Basis & Purpose  

o Explains rationale for rule adoption. 
o Must be in .doc format. 
o Must be accessible. 

 
• Regulatory Analysis (if completed, required)  

o Must be in .doc format. 
o Must be accessible. 

 

Optional Document(s): 
• Redline Copy of Rules 

o Highly encouraged 
o Shows edits to current rules resulting in the adopted rules. 
o Must use Track Changes. Do not use strikethrough formatting, as it is not 

accessible. 
o Must be in .doc format. 
o Must be accessible. 
o Ensure this document has been reviewed to confirm it contains no hidden or 

sensitive information. Use Word’s “Document Inspector” to remove any 
metadata, comments, or other content that should not be publicly accessible. 

Best Practices: 
• Review numbering and formatting carefully. 
• Publication notes, if provided, should remain in the submitted clean copy. 
• Use redline for transparency during hearings. 
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3. Emergency Rulemaking Notice 
Required Document(s): 

• Clean Copy of Rules 
o For publication in the Code of Colorado Regulations (CCR) and Colorado 

Register. 
o Must be free of tracked changes and comments. 
o Must be in .doc format. 
o Must be accessible. 

 
• Statement of Justification  

o Explains emergency adoption under C.R.S. § 24-4-103(6). 
o Must be in .doc format. 
o Must be accessible. 

 
• Statement of Basis & Purpose 

o Explains rationale for rule adoption. 
o Must be in .doc format. 
o Must be accessible. 

 
• Regulatory Analysis (required if completed) 

o Must be in .doc format. 
o Must be accessible. 

 

Optional Document(s): 
• Redline Copy of Rules 

o Highly encouraged 
o Shows edits to current rules resulting in the adopted rules. 
o Must use Track Changes. Do not use strikethrough formatting, as it is not 

accessible. 
o Must be in .doc format. 
o Must be accessible. 
o Ensure this document has been reviewed to confirm it contains no hidden or 

sensitive information. Use Word’s “Document Inspector” to remove any 
metadata, comments, or other content that should not be publicly accessible. 
 

Best Practices: 
• Clearly articulate emergency reasons. 
• Ensure all documents meet accessibility standards. 
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4. Additional Notes 
• Cost-Benefit Analysis: Not filed with SOS; only posted on agency website 

(COPRRR requirement). 
• Accessibility: All documents must comply with accessibility standards. 
• File Format: Always submit in .doc format. 
• Quality Check: Have another person review for accuracy before submission. 

 Other Helpful Information 

Colorado Register 
The Colorado Register is the official publication of the State of Colorado’s administrative 
rules. Before any administrative rule can take effect in Colorado, it must be published in 
the Colorado Register. This ensures transparency and gives the public an opportunity to 
participate in the rulemaking process. The Colorado Register is published on the 10th 
and 25th of every month. 

Footnotes 
Use Word’s Insert Footnote feature to create footnotes. 

1. Place your cursor where you’d like to have the footnote reference number in the 
body of text.  

2. Under the References tab, click “Insert Footnote” and type your footnote.  
 

Note: Microsoft’s Draft view does not show footnotes by default. To view them, 
select Draft from the “View” tab, then go to the “References” tab. Select “Show 
Notes.” Example: 
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Graphics - Maps, Tables, and Figures 
Submission Options: Maps, tables, and figures may be included within the rule 
document or submitted as separate files. If submitted separately, include a publication 
note indicating where the Administrative Rules Program staff should insert them in the 
text, and notify the staff by email at rule@coloradosos.gov.  

Formatting Guidelines: 

• Graphics and large tables may be displayed in landscape orientation for better 
readability. 

• Charts must be accompanied by a data table showing all data points used. 
• All charts and graphics must include alt text describing the visual for accessibility. 

History & Editor’s Notes 
This section is completed by the Secretary of State’s Office and does not need to be 
included in any of your rulemaking documents. 

Hyperlinks 
Hyperlinks and URLs included in rules text will be displayed as underlined text but 
disabled for publication in the CCR. 

Indents 
Use the “Indent” style options in the CCR Template to indent paragraphs or use the tab 
key. Do not use the space bar for indentation. 

Page Breaks 
If your rule is lengthy or you need specific sections to start at the top of a page, insert 
page breaks. This prevents paragraphs from splitting across pages and keeps long 
rules organized. To add a page break in Word, go to the ‘Insert’ tab on the ribbon and 
select ‘Page Break.’ 

  

mailto:rule@coloradosos.gov
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Sensitive Information 
Ensure that every submitted document has been thoroughly reviewed to confirm it 
contains no hidden or sensitive information. Use Word’s Document Inspector to remove 
any metadata, comments, or other content that should not be made publicly accessible. 

Document Inspector Instructions: 
1. Open the Word document. 
2. Select “File.” 
3. Click “Info.” 
4. Click “Check for Issues.” 
5. Select “Inspect Document.” 
6. Click “Inspect.” 
7. Review each category and click “Remove All” next to anything that should be 

cleared (comments, revisions, metadata, hidden text, etc.). 
8. Save the document. 

Spacing in Published Documents 
Our office may adjust spacing in published documents to improve readability. As the 
publisher, we follow established practices such as preventing paragraph breaks across 
pages. 

A paragraph break occurs when part of a paragraph appears at the bottom of one page, 
and the rest continues on the next page. To avoid this, we sometimes add extra spacing 
or insert page breaks so that each paragraph stays together on a single page. This 
ensures consistency and makes documents easier to read. 

These adjustments are applied uniformly across all rules to maintain a professional and 
accessible format. 
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